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Welcome to the AFF IoT Guide

This booklet contains information required to explore the circuits 

of the AFF IoT KIT.

When done with this booklet you’ll know how to start creating 

your own projects and experiments.

LET’S BEGIN!
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Fundamental concept
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Human and microcontroller analogy

VIBRATION

OBSTACLETEMPERATURE

HUMIDITY

LIGHT

A microcontroller is a computer presented in a single integrated 
circuit, dedicated to perform and execute some tasks. It contains 
memory, programmable input/output peripherals as well as brain.
It gathers data from environment using sensors; processes the 
collected data according to programmer’s needs, and then performs 
actions accordingly (control a motor, turn light on, etc.)

The brain is an organ that serves as the center of the 
nervous system.
It gathers data from environment using the sense organs; 
processes the collected data according to current needs 
along with similar past circumstances, and then sends 
orders to perform actions accordingly (walk, talk, etc.)



What is AFF IoT Board?
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• The Internet of Things (IoT) consists of things that are 

connected to the Internet, to be controlled/monitored at 
anytime, anywhere. Technically, it consists of integrating 

sensors and devices that are connected to the Internet 
over fixed or wireless networks

• IoT devices are part of the larger concept: home 

automation. It includes lighting, heating, air conditioning, 
media and security systems. Long term benefits include 

energy savings by automatically ensuring lights and 

electronics are turned off when not used.

• AFF IoT Board is an Arduino-compatible microcontroller 
board that includes embedded Wi-Fi Module.



AFF IoT Board
Components

1 Power In (Barrel Jack)

Provides power to the board, works with either a 9V or 12V 
adaptor or battery. Power supply ranges from 7V to 15V.

2 USB Port
Provides power and connects the board with computer via USB.

3-4 LEDs (RX: Receiving / TX: Transmitting)

These LEDs show when the microcontroller is 
receiving/transmitting data bits from/to the computer.

5 LED 13 (Built-in LED)
This LED is linked to the sketch to show if the program is running 
properly. It is connected via resistor to the digital pin 13.
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AFF IoT Board
Components

6 Pins (Ground, Digital, Rx, Tx)
Various pins can be used for digital inputs, outputs, and serial 
communication.

7 LEDs (Red and Blue)
The Red one is a simple power indicator LED. The Blue one 
indicates the status of the board (configured or not)

8 “FACTORY RESET” Button
Resets the board, it deletes the Wi-Fi and account data. (press 
for 5 seconds to reset)

9-10 “Wi-Fi RESET” Button & “RESET” Button
The first one restarts the Board’s Wi-Fi module and reconnects 
to the server, and the second restarts the microcontroller 
(restarts the code) (One Press).
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AFF IoT Board
Components

11 Pins (“ANALOG IN”, “POWER”)

Various pins can be used for analog inputs, outputs (3.3V and 
5V), and ground.

12 ESP Wi-Fi Module
Microcontroller with integrated TCP/IP protocol that gives the 
AFF IoT Board access to the Internet.

13 ICSP Pins (In Circuit Serial Programming)

These pins are used to program the board via programming 
tool kit.

14 AVR Microcontroller
This is the microcontroller of the AFF board, similar to the one 
used in the traditional Arduino UNO board.
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Download Arduino IDE*
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Access the internet
Download the newest version of the Arduino software 

from www.arduino.cc (it's free!). Type the following 

URL into the address bar of the browser: 
https://www.arduino.cc/en/Main/Software

Download

Choose the appropriate Operating System (Windows, 
MAC or Linux) installation package.

 1

 2

* IDE: Integrated Development Environment



About Arduino IDE
Open the Arduino IDE software on your computer 
and you will see a page similar to the one at the left.
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About Arduino IDE
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Verify

Compiles and verifies the code. It 
catches errors such as missing 
semi-colons or parenthesis.

Upload

Sends the code to the AFF IoT 
Board. When clicking it, the two 
yellow LEDs (RX and TX LEDs) on 
the board blink rapidly.

New

Opens up a new code window tab 
which contains only two functions: 
the setup() and loop() which 
are explained later.

Open

Opens up an existing sketch.

Save

Saves the current active sketch.

Serial Monitor

Opens a window that displays any 
serial information the AFF Board is 
transmitting. It is very useful for 
debugging.

Sketch Name

Displays the name of the sketch.

Code Area

Dedicated area for composing the 
sketch’s code.

Message Area

Notifies the programmer 
about  error (s )  in  the 
code and once the code 
is verified.



12

This function is used to setup all configurations for pins and interfaces and 
initial values for used variables.

This function runs once upon powering up the board and when pressing 
“RESET” button.

setup() function

All lines of code written in this function will run repeatedly as long as the 
board is powered.

This function is used to execute the code infinitely.

loop() function

Arduino essential functions
// this is for single line comments

// it’s good to put a description at

// the top and before anything ‘tricky’

/* this is for multi-line comments

   Like this…  

   And this…. */



Learn programming and 
coding basics
In the next section all  necessary programming 
concepts needed to program the AFF IoT board are 
explained with some illustrative examples.
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Integer Variables

- A variable is like "bucket", it 
holds numbers or other values 
temporarily.

- Any variable can be assigned 
with a particular value using 
the equal operator “=“.

- All arithmetic operations can 
be used and the result of it 
can be stored at another 
variable.

String Variables
- This type of variables is 
intended to store characters 
which compose a word or 
phrase.

- Same as integer type, String 
variables can be combined 
together to compose another 
String using the plus operator 
“+”.

Defined Variables
- It is similar to constant 
variables.

- It is usually used to assign pin 
numbers to the physical 
components.

- No need to declare its type, it 
can be assigned directly

- It is defined without equal 
operator “=“ 

Constant Variables

- This type of variables can be 
assigned once and cannot be 
changed anywhere in the code.

- It can be declared by adding 
the “const” word before its 
type.

- Trying to assign another 
value to a constant variable 
cause a compiling error.

Decimal & long 
Variables

- Decimal variable is declared 
by using the type named 
“float”.

- Long variable is similar to the 
integer variable but it can 
store higher values.

- Long variable range is 
defined between:

-2147483647 & +2147483646



General concept
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Functions and Libraries

Functions
Libraries

- A function is a group of statements that together perform 
a task.

- A function can take some parameters (a and b in the 
example) perform some actions (addition in the example) 
and return the value (the sum of a and b which is c).

- It can also take no parameters and has no return value 
(declared as void function) such as print function.

- Libraries are files written in C or C++ (.c, .cpp) which provide your 
sketches with extra functionality (e.g. the ability to control a servo 
motor, or read an encoder, etc.). These statements make the 
public functions and constants defined by the library available to 
your sketch.

- To use an existing library in a sketch simply go to the Sketch menu, 
choose "Import Library", and pick from the libraries available. This will 
insert an #include statement at the top of the sketch for each            
header (.h) file in the library's folder. 



Control Structure
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The most important statement!

The if statement checks for a condition and executes the proceeding statement or set of 
statements if the condition is 'true‘.

The brackets may be omitted after an if statement. If this is done, the next line (defined 
by the semicolon) becomes the only conditional statement.

The statements being evaluated inside the parentheses require the use of one or more 
operators shown below.

Comparison Operators:

x == y (x is equal to y)

x != y (x is not equal to y)

x <  y (x is less than y)

x >  y (x is greater than y)

x <= y (x is less than or equal to y)

x >= y (x is greater than or equal to y)

Beware of accidentally using the single equal sign (e.g. if(x = 10) ). The single equal 
sign is the assignment operator, and sets x to 10 (puts the value 10 into the variable x). 
Instead use the double equal sign (e.g. if(x == 10) ), which is the comparison 
operator, and tests whether x is equal to 10 or not. The latter statement is only true if x 
equals 10, but the former statement will always be true.
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Register at AFF IoT app 
(available on Android and iOS)

After downloading the app (AFF IoT), 
create new account. Creating an 
account is a simple 10 steps procedure 
and takes less than 2 minutes. If you 
don’t have a smartphone, you can use 
the browser on the PC such as Chrome, 
Firefox, etc.

* If you face any problem while creating new account, or while logging in, 
please drop us an email to support@affcity.com
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AFF IoT App
1. Create an account by clicking on the green 

button “REGISTER”.

2. Complete the required information.

3. Then Login using your email and password.
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AFF IoT App
1. If you have an account, click on blue button 

“LOGIN”.

2. Then Login using your Email and Password.
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AFF IoT App

Next, register the AFF IoT Board 
(explained in next section). Then 
everything will be ready to build 
projects! 



Connect AFF IoT Board to the Computer

Use micro USB cable to connect the AFF IoT Board to

any of the computer’s USB ports.

Then open the Wi-Fi page on your smartphone or PC. 21
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If your network 
doesn’t listed, click 
“Scan Networks”

Choose your AFF 
IoT Board from 

the Wi-Fi list
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Click the button to go to 
affcity.com or cancel then 

open the AFF IoT App
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Finally…

Open the AFF IoT App and you 
should see the AFF IoT board 
connected the Internet.

It is named by default NEW 
MODULE, and can be edited.
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For PC users
The procedure is the same except 
instead of using the AFF IoT App, you 
should go to 
https://affcity.com/iot/modules.
Here you can continue same as 
described using the App.
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Build 12 projects



AFF IoT Kit includes:

Jumper wires x20

Various Colors

LEDs x27

Red x5, Green x5, Blue x5, 
Yellow x5,  White x5                

and RGB x2

Pushbutton x9

Squared shape pushbutton

Potentiometer x4

Variable resistor between

0Ω and 5kΩ

27



AFF IoT Kit includes:

10KΩ Resistor x6

0.5W 5%

1KΩ Resistor x4

0.5W 5%

330Ω Resistors x25

0.25W 5%

Photocell x2

Light Dependent Resistor (LDR)

28



AFF IoT Kit includes:

DHT11 x1

Humidity and Temperature 
sensor

Thermistor x3

1KΩ at 25°C

Piezo Buzzer x2

Polarized Piezo buzzer

Breadboard x1

400 pins solderless breadboard

29
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VCC:
Each + sign runs power anywhere 
in the vertical column.

GND:
Each - sign runs ground 
anywhere in the vertical column.

Horizontal Rows: (a-e & f-j)
Each of these rows numbered 
from 1 to 30 are comprised of 
five horizontal sockets.
Components placed in the same 
row will be connected together.

Breadboard
A breadboard is a construction base for 
prototyping of electronics.
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1 Blinking Built-in LED

The first program every programmer learns consists in writing 
enough code to make their code show the sentence "Hello World!" 
on a screen. The blinking LED is the "Hello World!" of physical 
computing. In this tutorial the needed component is only the AFF 
IoT board and the micro USB cable.
This tutorial consist of turning the built-in LED 
(LED13) ON for one second, then OFF for one second, 
repeatedly.



Connect AFF IoT Board to the Computer

Use micro USB cable to connect the AFF IoT Board to

any of the computer’s USB ports. 
33
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Select board: 
Arduino/Genuino Uno

Note:

AFF IoT Board is not listed in the Arduino 
Software.

Select “Arduino/Genuino Uno” instead.
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Select the serial device of the Board from the 
Tools → Serial Port menu. To find out which 
port, you can disconnect the Board and re-
open the menu; the entry that disappears 
should be the Board. Reconnect the board 
and select that serial port. Please note that 
the number of serial port may differs from 
the example used.

Select the serial 
device: (Windows)

Note: If you cannot see the board please refer to the following link:                             
https://learn.sparkfun.com/tutorials/how-to-install-ftdi-drivers/windows---in-depth!
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Select the serial 
device: (for Mac)
Select the serial device of the Board from the 
Tools → Serial Port menu. This should be

something like

/dev/tty.usbmodem or

/dev/tty.usbserial
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Open the Blink 
example
After connecting the AFF IoT board to the 
computer, open the Blink example listed 
in the written examples in the Arduino 
IDE.
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Blink example

This example is the alphabet 
of the microcontroller world!



Code to note..
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digitalWrite(LED_BUILTIN, HIGH): A digital output pin is either set to be HIGH 
(output 5 volts), or LOW (output 0 volts). We should choose which pin to be set in the first 
parameter (LED_BUILTIN in the example), and the value desired (HIGH in the example).

pinMode(LED_BUILTIN, OUTPUT): Before you can use one of the board's pins, the 
pin has to be specified as an INPUT (to read a sensor data) or OUTPUT (control an 
actuator). We use a built-in "function" called pinMode()to set the pin13 (which LED13 is 
connected to) as OUTPUT.

delay(1000): It pauses the program for the amount of time (in 
milliseconds) specified as parameter. (There are 1000 milliseconds in a second).
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Finally..

1

This compiles your code. The IDE 
changes it from text into 
instructions the microcontroller 
can understand.

This sends the instructions via the 
USB cable to the microcontroller 
chip on the Board. The Board will 
then begin running the code 
automatically.

1



What you should see
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You should see your LED turn on for one second then turn off for one second and so on. If 
it isn't, make sure you have uploaded the code correctly to the board and there is no 
compiling error or see the troubleshooting tips below.

Program Not uploading?
It happens sometimes, the most 
likely cause is choosing wrong 
serial port, you can change this 
in Tools → Port

Troubleshooting

LED13 Not Lighting Up?
Make sure the board is 
plugged into the PC 
correctly

Still Not uploading?
The common solution for 
almost all electronic devices is 
to turn it OFF then turn it ON



 LED x1 330Ω Resistor x1 Pushbutton x2

42

Controlling LED with Pushbuttons2

10KΩ Resistor x2 Jumper wires x7
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Pushbutton
One of the most common and simple 
inputs is a push button. The way a push 
button works with board is that when 
the button is pushed, the voltage goes 
LOW. The board reads this and reacts 
accordingly. In this circuit, a pull-up 
resistor will be used to keep the voltage 
HIGH at 5V when the button is not 
pressed.



Be careful!
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LED:
The short leg, marked with flat side, 
goes into the negative position (-).

330Ω Resistor:
The color banding should read 

orange-orange-brown-gold. 

The component legs can go in either 
hole..
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How to use LOGIC

You could turn on a heater if it gets too 
cold, a fan if it gets too hot, water the 
plants if they get too dry, etc. In order to 
make such decisions, there are set of 
logic operations. It can be combined to 
build complex if() statements.

For example:
if ((mode == heat) && ((temperature < threshold) || (time == “night”)))

digitalWrite(HEATER, HIGH);
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Open your sketch: 
Using_Pushbuttons

AFF IoT Board folder > Circuits > Using_Pushbuttons



Code to note..
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Button1State = digitalRead(Button1Pin): To read a digital input, we use the 
digitalRead() function. It will return HIGH (or 1) if there's 5V present at the pin, or 
LOW (or 0) if there's 0V present at the pin.

pinMode(Button1Pin, INPUT): The digital pins can be used as inputs as well as 
outputs. It’s specified as INPUT  in order to read the state of the button.

if (Button1State == LOW): Because we've connected the button to GND, it will 
read LOW when it's being pressed. The "equivalence" operator ("==") is used to see if the 
button is pressed.

else: the else statement means that if the condition in the if statement is 
false, the code in else brackets are executed.



You should see the LED turn on if you press either button, and off if you press both buttons 
(see the code ). If it isn’t working, make sure you have assembled the circuit correctly and 
verified and uploaded the code to your board or see the troubleshooting tips below.

What you should see

49

Troubleshooting

LED Not Turning On?
The pushbutton is square, and 
because of this it is easy to put it 
in the wrong way. Give it a 90 
degree rotation and see if it 
starts working.

Still not lighting up?
LEDs will only work in one direction. Try 
taking it out and twisting it 180 degrees 
(don’t worry, installing it the opposite way 
doesn’t damage the LED).



Real World Application

Buttons in most video game controllers.



Jumper wires x7 Green LED x1 Potentiometer x1
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330Ω  Resistor x1

Dimming LED using Potentiometer3
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Potentiometer
(variable resistor)

The potentiometer has 3 pins, 2 outer-pins and 
1 inner. When it’s connected with 5 volts across 
its two outer pins, the middle pin outputs a 
voltage between 0V and 5V, depending on the 
position of the knob on the potentiometer. A 
potentiometer is a demonstration of a variable 
voltage divider circuit. In this circuit, you’ll learn 
how to use a potentiometer to control the 
brightness of an LED.

Note that analog pins A0 
and A1 are reserved for 
communication with the 
Wi-Fi module, so please 
don’t use them, otherwise 
the board won’t work 
properly !



Digital or Analog
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TO

But there are also a lot of things out there that aren't just 
"on" or "off". Temperature levels, light intensity, etc. All 
have a continuous range of values between “HIGH” and 

“LOW”. For these, the board offers six analog inputs that 
translate an input voltage into a value that ranges from 0 (0 

volts) to 1023 (5 volts). The analog pins are perfect for 
measuring all those "real world" values.

Many devices, such as LEDs and push-buttons, have only 

two possible states: “on” and “off”, or as they're known as 

"HIGH" (5 volts) and "LOW" (0 volts). The digital pins of a 

board are useful at transmitting/receiving signals to and 

from  the  outside  world,  and  can  even  do  tricks  l ike 

simulated dimming (by blinking on and off really fast), and 

serial communications (transferring data to another device 

by encoding it as patterns of voltage HIGH and LOW).

OR
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Is there a way for the 
IoT-Board to output 
analog voltages?

The AFF IoT Board does not have a true analog 

voltage output. But, because the Board is so fast, 
i t  can  fake  i t  using  something  cal led  PWM 

("Pulse-Width Modulation"). The pins on the 

Board with “~” next to them are PWM/Analog out 
compatible. The microcontroller is so fast that it 
can blink a pin on and off almost 1000 times/s.

PWM goes one step further by varying the amount of time that the blinking pin spends “HIGH” vs. the time it 
spends “LOW”. If it spends most of its time “HIGH”, a LED connected to that pin will appear bright. If it spends 

most of its time “LOW”, the LED will look dim. Because the pin is blinking much faster than your eye can detect, 
the Board creates the  illusion of a "true" analog output.
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Open your sketch: 
Dimming_LED_using_Potentiometer

AFF IoT Board folder > Circuits > Dimming_LED_using_Potentiometer 



Code to note..
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analogValue = analogRead(PotentiometerPin): analogRead() function is 
used to read the value at an analog input pin. analogRead() takes one parameter, here 
the analog pin (“PotentiometerPin"), and returns a value (“analogValue") between 0 
(0 volts) and 1023 (5 volts).

int analogValue: Variables must be declared before using them; here we're 
declaring a variable called analogValue, of type "int" (integer). Don't forget that variable 
names are case-sensitive!

analogWrite(GreenLedPin, analogValue): analogWrite function is used to 
generate a PWM signal in the GreenLedPin with duty cycle equal to analogValue 
(duty cycle is the percentage of High voltage (5V) over a period).



Code to note..
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analogValue = map(analogValue, 0, 1023, 0, 255)
Reading an analog signal using analogRead(), returns a number from 0 to 1023. But to drive a PWM 
pin using analogWrite(), it requires a number from 0 to 255. so it should "squeeze" the larger range 
into the smaller range using the map()function.

map(value, fromLow, fromHigh, toLow, toHigh)
value: the variable to be mapped
fromLow: the lower bound of the value's current range
fromHigh: the upper bound of the value's current range
toLow: the lower bound of the value's desired range
toHigh: the upper bound of the value's desired range



You should see the LED becomes brighter or darker in accordance with the position of your 
potentiometer. If it isn’t working, make sure you have assembled the circuit correctly and verified 
and uploaded the code to your board, or see the troubleshooting below:

What you should see
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Troubleshooting

Sporadically Working
This is most likely due to a 
slightly dodgy connection with 
the potentiometer pins. Try 
pressing the potentiometer.

LED Not Lighting Up?
LEDs will only work in only one 
direction. Try taking it out and 
rotate it 180 degrees (don’t 
worry, installing it the opposite 
way doesn’t damage the LED).

Not Working
Make sure you haven’t 
accidentally connected the 
resistive element in the 
potentiometer, to digital pin 2 
rather than analog pin A2. (the 
row of pins beneath the power 
pins).



Real World Application

Most traditional volume knobs employ a potentiometer.
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4 Using Serial Monitor

One of the most important things in 
Arduino IDE is the “Serial Monitor”.



Serial Communication
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A serial bus consists of just two wires - one for sending data 
and another for receiving. As such, serial devices should 
have two serial pins: the receiver, RX, and the 
transmitter, TX.

In serial communication the data are 
sent one after other, until the end of all 
bytes.

The data are sent from the 
sender to receiver like 
pulling tennis balls from 
the container tube.
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Open your sketch: 
Using_Serial_Monitor

AFF IoT Board folder > Circuits > Using_Serial_Monitor



Serial Monitor
This example uses the Arduino IDE's Serial monitor. To open it, first upload the program then 
click the button which looks like a magnifier in a square. In order for the serial monitor to operate 
correctly it must be set to the same baud rate (speed in bits per second) as the code running. The 
code runs at 9600 baud rate; if the baud rate setting is not 9600, please change it to 9600.

1

2

64



Code to note..
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Serial.println(“Hello World”): The Serial.println() command prints out 
anything written within the bracket, including variables of all types then moves to the 
next line. 

However, Serial.print() prints everything on the same line.

for more info, visit http://arduino.cc/en/serial/print

Serial.begin(9600): Before using the serial monitor, you must call 
Serial.begin() to initialize it. 9600 is the "baud rate", or communications speed. 
When two devices are communicating with each other, both must be set to the same 
speed. The serial monitor is used to debug the code also.



What you should see
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Troubleshooting

You should see a “Hello World” phrase printed on the Serial monitor every one second.

Gibberish is Displayed
This happens because the 
serial monitor is receiving data 
at a different speed than 
expected. Click the pull-down 
box that reads “xxxx baud" and 
change it to "9600 baud".

Nothing is Displayed
Try to exit the Serial monitor 
then start it again.

Nothing happen when opening 
Serial Monitor
Try to find the Serial monitor 
window in the windows taskbar by 
hovering the mouse over the 
Arduino icon then click on the 
Serial monitor tab.



Red LED x1 330Ω Resistor x1 Jumper wires x3

67

Controlling an LED (via “Internet”)5
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Control an LED
LEDs (light-emitting diodes) are small, 
but powerful light source that are used in 
many different applications. First we will 
work on blinking an LED. It is simple and 
basic function, yet, it is the basis for 
further complex functions.
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Control the LED 
by clicking ON 
and OFF

Scroll down, 
and click 
ADD

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.

Fill in the blank 
the following 
parameters



Before Start!
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Instructions to add a new library (mandatory to communicate with the Wi-Fi module)

1 3

4

1) Open Arduino IDE and Click Tools, 
Manage Libraries.

2) Search for “NeoSWSerial”.
3) Then click Install.
4) Once download finish, click Close.

2
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Open your sketch: 
Controlling_an_LED

AFF IoT Board folder > Circuits > Controlling_an_LED This is where you 
will find the 

Arduino code for 
each circuit



Code to note..
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#include <NeoSWSerial.h>: This line of code consists of importing the Software 
Serial library, this library consists of making any two pins to be the transmit pin (Tx) and 
receive pin (Rx) of a serial communication between the board and another device (Wi-Fi 
module in AFF IoT board).

The function of this library is similar to the normal hardware Serial.

NeoSWSerial WiFiModule(Rx, Tx): Here a variable of type “NeoSWSerial” 
named “WiFiModule” is declared. It assigns the two pins A0 and A1 to be the transmit 
and receive pins for the serial communication with the Wi-Fi module



Code to note..
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WiFiModule.available(): this function tests if the Wi-Fi module has received a command from 
the internet and returns the number of bytes received.

Note: if there is no data, the return value of this function is 0. 

String command = WiFimodule.readStringUntil('\n'): here a String variable named 
command is declared, and it will be assigned by the command text received from the Wi-Fi module. 
readStringUntil('\n') means that the board continue receiving data until the character '\n' 
is received ('\n' is the representation of the ENTER key on the keyboard).

Note: always use the this line of code same as written to get the command sent by the Wi-Fi module.

if(command.indexOf(“red_led”) >= 0): the function indexOf() tests if the 
string between parenthesis (as parameter) exists in the caller string (command string in 
the example) and returns the index where it exits. If the parameter string doesn’t exist in 
the caller string, the function returns -1.



What you should see
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You should see your LED turn on and off when you click on the toggle button at the dashboard in the 
AFF IoT application. If it isn't, make sure you have assembled the circuit correctly and verified and 
uploaded the code to your board or see the troubleshooting tips below.

Program Not uploading?
It happens sometimes, the most 
likely cause is choosing wrong 
serial port, you can change this 
in Tools → Serial Port

Troubleshooting

LED Not Lighting Up?
LEDs will only work in one 
direction. Try taking it out and
twisting it 180 degrees (don’t 
worry, installing it the opposite 
way doesn’t damage the LED).



Real World Application

On/Off indicator in various electronic devices



Jumper wires x5 1KΩ Resistor x1 Photocell x1
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Reading Light Intensity (via “Internet”)6
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Photocell
A photocell is a resistor that its value 
varies with the change of light intensity. 
When bright, the resistor decreases, and 
the voltage (in the example circuit) 
increases.

When it is dark, the resistor increases, 
and the voltage (in the example circuit) 
decreases.
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you can monitor 
the light intensity 
in the room

Scroll down, 
and click ADD

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.

Fill in the blank 
the following 
parameters



83

Open your sketch: 
Reading_Light_Intensity

AFF IoT Board folder > Circuits > Reading_Light_Intensity



What you should see
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You should see the gauge value increase or decrease in accordance with how much light the 
photocell is reading. If it isn't working, make sure you have assembled the circuit correctly and 
verified and uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting

Still not quite working
You may be in a room which is 
either too bright or dark.
Try turning the lights on or off 
to see if this helps. Or if you 
have a flashlight near by, give 
that a try.

It isn't responding to 
changes in light
Given that the spacing of the 
wires on the photocell is not 
standard, it is easy to 
misplace it on the breadboard. 
Double check it’s in the right 
place.



Real World Application

A street lamp uses light sensor to detect when to turn light ON



Thermistor x1 1KΩ resistor x1 Jumper wires x5

86

Monitoring Temperature (via “Internet”)7
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Thermistor
A thermistor is a type of resistor whose 
resistance is dependent on temperature, more 
sensitive than standard resistors. The word is a 
portmanteau of thermal and resistor. Thermistors 
are widely used as temperature sensors (Negative 
Temperature Coefficient or NTC type 
typically), self-regulating heating 
elements (Positive Temperature Coefficient 
or PTC type typically). With NTC thermistors, 
resistance decreases as temperature increases.
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you can monitor 
the room 
temperature

Scroll down, 
and click 
ADD

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.

Fill in the blank 
the following 
parameters
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Open your sketch: 
Monitoring_Temperature

AFF IoT Board > Circuits > Monitoring_Temperature



What you should see
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Troubleshooting

Temperature Value is Unchanging
Try rubbing the sensor with your 
fingers to heat it up or pressing a bag 
of ice close to it to cool it down.

You should be able to read the temperature your temperature sensor is detecting, on the serial 
monitor in the Arduino IDE and on your app. If it isn't working, make sure you have assembled 
the circuit correctly and verified and uploaded the code to your board or see the 
troubleshooting tips.

Gibberish is Displayed
This happens because the serial 
monitor is receiving data at
a different speed than expected. 
Click the pull-down box that 
reads "*** baud" and change it 
to "9600 baud".



Real World Application

Climate control systems use a temperature sensor
to monitor and maintain cooling/heating settings.



DHT11 x1 10KΩ resistor x1  Jumper wires x6

“Humidity and Temperature sensor”
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Measuring Humidity & Temperature (via “Internet”)8
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DHT11 sensor
DHT11 Temperature and Humidity Sensor  

Features a temperature and humidity sensor 
complex with a calibrated digital signal output.

The sensor includes humidity measurement 
component and an NTC temperature 
measurement component.

Note: pin3 
remains not 
connected
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Scroll down, 
and click ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Scroll down, 
and click 
ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Open your sketch: 
Measuring_Humidity_
and_Temperature

AFF IoT Board > Circuits > Measuring_Humidity_and_Temperature
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Before Compiling 
the code
Download the DHT library

Sketch > Include Library > Manage 
Libraries 
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Before Compiling 
the code
Download the DHT library

Search for “dht”, select the newest 
version of “SimpleDHT library” and 
click “Install”.
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Before Compiling 
the code
Download the DHT library

After Clicking “Close” button, we can 
see that the Arduino IDE recognizes 
the type of SimpleDHT and changes 
its color to orange.

Library added!



Code to note..
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This line of code calls the read function to 
get the humidity and temperature from the 
DHT11 sensor, and puts the values into the 
variables ‘temperature’ and ‘humidity’.

dht.read(&temperature, &humidity, NULL): 



What you should see
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You should see real humidity and temperature values. If it isn't working, make 
sure you have assembled the circuit correctly and verified and uploaded the 
code to your board or see the troubleshooting tips below.

Troubleshooting

Nothing seems to happen
This program has no outward 
indication it is working. To see the 
results you must open the AFF IoT 
application.

Values are unchanging
Try rubbing the sensor with your 
fingers to heat it up or pressing a 
bag of ice close to it to cool it 
down.



    Real World Application

Measure the humidity and temperature at storage rooms 
to prevent damage of stored items



RGB LED x1 330Ω Resistor x3 Jumper wires x5
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Adjusting RGB LED color (via “Internet”)9
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RGB LED

RGB, or red-green-blue, LEDs have three 
different color-emitting diodes that can 
be combined to create all sorts of colors. 
In this circuit, you’ll learn how to use an 
RGB LED to create unique color 
combinations.

Depending on how bright each diode is, 
nearly any color is possible!
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select the 
color then 
click choose 
button

Scroll down, 
and click ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Open your sketch: 
Adjusting_RGB_LED_Color

AFF IoT Board folder > Circuits > Adjusting_RGB_LED_Color

1
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Open your sketch: 
Adjusting_RGB_LED_Color

AFF IoT Board folder > Circuits > Adjusting_RGB_LED_Color

2



Code to note..
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RedValue = RedStringValue.toInt(): the function toInt() converts a valid 
String to an integer. The input String should start with an integer number. If the String 
contains non-integer numbers, the function will stop performing the conversion. 

Command.substring(index): with only one parameter, it looks for a given substring 
from the assigned index to the end of the string (Command in this example).



What you should see
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Troubleshooting

LED Remains Dark or Shows 
Incorrect Color
With the four pins of the LED so 
close together, it’s sometimes 
easy to misplace one. Double 
check each pin where is inserted.

You should see your LED turn on, but this time in new, crazy colors! If it isn't, make sure 
you have assembled the circuit correctly and verified and uploaded the code to your 
board or see the troubleshooting tips below.

Seeing Red
The red diode within the RGB LED may be a bit 
brighter than the other two. To make your colors 
more balanced, use a higher Ohm resistor for the 
red one. Or adjust in code. 
analogWrite(RedLedPin, RedValue);
To analogWrite(RedLedPin, RedValue/3);



Real World Application

Many electronic devices such as videogame consoles use RGB LEDs to 
show different colors within the same light source.



White LED x1 330Ω Resistor x1 Jumper wires x3

117

Scheduling controls10
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Turn ON/OFF
an LED
LEDs (light-emitting diodes) are small, 
but powerful light source that are used in 
many different applications. First we will 
work on controlling an LED. It is simple 
and basic function, yet, it is the basis for 
further complex functions.
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Control the LED 
by clicking ON 
and OFF

Scroll down, 
and click ADD

Next step: 
setup a 
schedule

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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you can edit, delete, 
or disable the 
schedule
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Explanation

- Active: select the state of the schedule (Active or not).

- Title: is the title of the created schedule.

- Feature: is the control to be scheduled (Set ON or OFF).

- Time: is the time when the action will be executed.

- Start date: is the date when the schedule will be activated.

- Repeatable days: if the REPEAT checkbox is checked, you

can choose what are days the schedule is active.

- Save Schedule or Cancel it.



124

Timer

The timer option consists of 
choosing a control and setting a 
delay time. After this delay the 
control will be executed.

You can also stop the timer by 
clicking on STOP button, and the 
delayed action will be discarded.
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Open your sketch: 
Scheduling_Controls

AFF IoT Board folder > Circuits > Examples > Scheduling_Controls

This sketch will work same as the 
Controlling LED example (project 5) but 
with change in LED name.



What you should see
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You should see the LED turns ON after 10 seconds. If you select the OFF 
option, you should see the LED turns OFF after the delay time.

Troubleshooting

LED Not Lighting Up?
LEDs will only work in one 
direction. Try taking it out and
twisting it 180 degrees (don’t 
worry, installing it the opposite 
way doesn’t damage the LED).



Real World Application

Most IoT devices are built with integrated timers



Photocell x1 Yellow LED x1 330Ω Resistor x1
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1KΩ Resistor x1

 Jumper wires x5

Simulating automated lighting 
system

11
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Simulating real 
system

A simulation is an imitation of a real-
world operation.

So in real-world, instead of LED, a light 
bulb is used.

LED is used instead of light bulb for 
safety reasons while applying several 
trials.
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Scroll down, 
and click ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Scroll down, 
and click ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Click ADD 
NEW RULE

Click ADD 
CONDITION

Click NEXT

Select the 
board
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Select Light 
Intensity

Click EDIT 
ACTIONS

1

2

3
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Click FINISH

Turn lamp ON

You can edit, delete, 
or deactivate the 
rule

Now when the 
light intensity is 
lower than 50% 
then the yellow 
LED (lamp in real 
life) turns ON

Click BACK 
to return
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Finally

Repeat the process but instead select the light 
intensity to be lower grater 50% and the action is 
to turn OFF.

You can adjust the light intensity percentage to fit 
your room light.
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Open your sketch: 
Automated_Lighting_System

AFF IoT Board folder > Circuits > Examples > Automated_Lighting_System



What you should see
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You should see the yellow LED turns ON when the brightness in 
the room decreases, and OFF when the brightness increases.

Troubleshooting

Refer to the troubleshootings 
for the Controlling_LED and the 
Reading_Light_Intensity projects.



Real World Application

Recently, most lamps come with integrated light sensor. They turn ON when the light is 
lower than preset threshold, and OFF otherwise.



Piezo buzzer x1 Thermistor x1  Jumper wires x7
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1KΩ Resistor x1

Building overheat alarm circuit12
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Piezo Buzzer

We'll be using a buzzer that makes a 
“tone" sound when applying voltage to it !

This tutorial is the introduction to the 
Alarm systems.
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Scroll down, 
and click ADD

Fill in the blank 
the following 
parameters

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.
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Scroll down, 
and click ADD

LABEL NAME: is the name that appears in the application.
PARAMETER NAME: is the name used in the code.

Fill in the blank 
the following 
parameters
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Click ADD 
NEW RULE

Click ADD 
CONDITION

Click NEXT

Select the 
board
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Select 
Temperatur
e

Click EDIT 
ACTIONS

1

2

3
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You can edit or 
delete the rule
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Open your sketch: 
Overheat_Alarm

Open AFF IoT Board// Circuits > Examples >Overheat_Alarm

In this tutorial, we assumed that a 
temperature sensor is installed in the room. 
When the temperature rise to reach the 
350C the buzzer should produce an alarm 
sound.

This code is a combination of the code to 
control the buzzer and the code to stream 
the temperature.



What you should see
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You should see nothing! But you should hear a sound when you approach a lighter toward the 
sensor. If it isn't working, make sure you have assembled the circuit correctly and verified and 
uploaded the code to your board or see the troubleshooting tips below.

Troubleshooting

Still No Sound !
This Piezo is polarized, so take 
care that the pin with label “+” 
should be connected to the digital 
pin, and the other one to GND.

No Sound
Given the size and shape of the 
piezo buzzer it is easy to miss the 
right holes on the breadboard. 
Double check its placement.



Real World Application

All security systems use buzzers (or siren) upon triggering an alarm
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